# Table Of Contents

- Product Overview ..................................................................................................................... 1
- Copyrights .................................................................................................................................. 1
- End User License Agreement ..................................................................................................... 1
- Export Control Laws .................................................................................................................. 1
- Versions of the Software ............................................................................................................ 2
- License to Use .......................................................................................................................... 2
- No Additional Licenses .............................................................................................................. 3
- Costs of Litigation ...................................................................................................................... 3
- Disclaimer of Warranty ................................................................................................................ 3
- LIMITATION OF LIABILITY ....................................................................................................... 3
- What’s new ............................................................................................................................... 4
- Feature matrix ........................................................................................................................... 4
- Unavailable features ................................................................................................................. 6
- Installation ............................................................................................................................... 7
- System requirements .................................................................................................................. 7
- Installing Genie Timeline ......................................................................................................... 7
- Registering Genie Timeline ...................................................................................................... 7
- Updating Genie Timeline ......................................................................................................... 8
- Upgrading from the previous version ......................................................................................... 8
- Uninstalling Genie Timeline ..................................................................................................... 8
- Genie Timeline basics .............................................................................................................. 10
- What can Genie Timeline do? ................................................................................................. 10
- When are your files protected? .............................................................................................. 10
- Protecting open files ............................................................................................................... 11
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customize Backup</td>
<td>26</td>
</tr>
<tr>
<td>Configure email notifications</td>
<td>27</td>
</tr>
<tr>
<td>Genie Timeline Monitor</td>
<td>27</td>
</tr>
<tr>
<td>Create Disaster Recovery startup disk</td>
<td>28</td>
</tr>
<tr>
<td>Start a new backup</td>
<td>29</td>
</tr>
<tr>
<td>Restoring from an older backup</td>
<td>29</td>
</tr>
<tr>
<td>Searching the Backup</td>
<td>29</td>
</tr>
<tr>
<td>Retrieve deleted files that have been backed up</td>
<td>30</td>
</tr>
<tr>
<td>Disaster Recovery</td>
<td>30</td>
</tr>
<tr>
<td>Open current location in Timeline Explorer</td>
<td>31</td>
</tr>
<tr>
<td>Add items to backup from context menu</td>
<td>31</td>
</tr>
<tr>
<td>Show versions of backed up files</td>
<td>32</td>
</tr>
<tr>
<td>Exclude files from backup</td>
<td>32</td>
</tr>
<tr>
<td>Genie Timeline Dashboard</td>
<td>34</td>
</tr>
<tr>
<td>Genie Timeline Dashboard</td>
<td>34</td>
</tr>
<tr>
<td>Dashboard information</td>
<td>34</td>
</tr>
<tr>
<td>Backup controls and options</td>
<td>35</td>
</tr>
<tr>
<td>Preferences</td>
<td>36</td>
</tr>
<tr>
<td>Preferences</td>
<td>36</td>
</tr>
<tr>
<td>General</td>
<td>36</td>
</tr>
<tr>
<td>Auto-Exclude</td>
<td>37</td>
</tr>
<tr>
<td>Windows Explorer Enhancements</td>
<td>38</td>
</tr>
<tr>
<td>The System Tray Agent</td>
<td>39</td>
</tr>
<tr>
<td>Running backups</td>
<td>40</td>
</tr>
<tr>
<td>Running Backups</td>
<td>40</td>
</tr>
<tr>
<td>Pause/Resume Backup</td>
<td>40</td>
</tr>
</tbody>
</table>
Table Of Contents

Force a backup to run ...........................................................................................................40
Backup modes .....................................................................................................................41
Windows Enhancements ........................................................................................................42
Windows Enhancements........................................................................................................42
Backup markers ...................................................................................................................42
Context menu options ...........................................................................................................43
Timeline Explorer .................................................................................................................43
Explore in Timeline from any Window .....................................................................................44
No-Backup Zone ..................................................................................................................44
Restoring ...............................................................................................................................45
View/Restore Files ................................................................................................................45
Timeline Explorer .................................................................................................................45
Timeline Explorer .................................................................................................................45
View files in Timeline Explorer .............................................................................................46
Restoring from Timeline Explorer .........................................................................................46
Advanced Restore ................................................................................................................47
Title .........................................................................................................................................47
Advanced Restore ..............................................................................................................47
Title .........................................................................................................................................48
Select data to restore .............................................................................................................48
Restoring from an older backup ...........................................................................................48
Title .........................................................................................................................................49
Set Restore Options .............................................................................................................49
Title .........................................................................................................................................49
Restore Progress ..................................................................................................................49
Disaster Recovery ................................................................................................................50
Product Overview

Genie Timeline is a time machine for Windows that performs real time and continuous data protection. It can backup a wide variety of data types, such as System Files, emails, documents, music, pictures and practically anything else on your machine. It seamless backs up your data in the background, working as a parallel universe with computing history. Deleted & backed up files can be retrieved easily by a click of a button.

Copyrights

Copyright© Genie9 Corporation 2002-2012. All rights reserved.

Warning: This computer program is protected by copyright law and international treaties. Unauthorized production or distribution of this program, or any portion of it that's owned by Genie9, may result in severe civil and criminal penalties, and will be prosecuted to the maximum extent possible under the law.

Outlook Express®, Outlook®, Internet Explorer®, Windows® and Microsoft® are Registered Trademarks of Microsoft® Corporation

All trademarks and registered trademarks used in this documentation are property of their respective owners.

End User License Agreement

PLEASE READ THIS DOCUMENT (THIS "AGREEMENT") CAREFULLY BEFORE USING THE SOFTWARE PROVIDED ALONG WITH THIS AGREEMENT (THE "SOFTWARE"). BY CLICKING "I ACCEPT THE TERMS IN THE LICENSE AGREEMENT", YOU AGREE TO THE TERMS OF THIS AGREEMENT AND TO THE Genie9 PRIVACY POLICY, WHICH IS INCORPORATED IN THIS AGREEMENT AND CAN BE FOUND AT Genie9’S WEBSITE (HTTP://WWW.Genie9.COM/ABOUTUS/LEGAL.HTML). IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, PROMPTLY DELETE AND DESTROY ALL COPIES OF THE SOFTWARE.

Export Control Laws

Product, including software and documentation, available on the Genie9’s website is subject to export controls administered by the United States and other countries. Diversion contrary to U.S. law is prohibited. Export, re-export or import of certain product may require action on your behalf prior to purchase and it is your responsibility to comply with all applicable international, national, state, regional and local laws, and regulations, including any applicable import and use restrictions. Genie9 products are currently prohibited for export or re-export to Cuba, North Korea, Iran, Iraq, Libya, Syria
and Sudan or to any country subject to relevant trade sanctions. In addition, Genie9’s products are prohibited for export or re-export to any person or entity on the U.S. Department of Commerce Denied Persons, Entities and Unverified Lists, the U.S. Department of State’s Debarred List, or on the U.S. Department of Treasury’s lists of Specially Designated Nationals, Specially Designated Narcotics Traffickers or Specially Designated Terrorists, as the same may be revised from time to time, or for use with chemical or biological weapons, sensitive nuclear end-users, or missiles. By downloading or using product from this site, you are agreeing to the foregoing and all applicable export control laws. You are also warranting that you are not under the control of, located in, or a resident or national of any such country or on any such list. The information on export laws provided herein is not necessarily complete. For more information on export laws, please contact the U.S. Department of Commerce, Bureau of Industry and Security (BIS). More information on BIS can be found at: http://www.bis.doc.gov.

Versions of the Software

There are four versions of GENIE TIMELINE (free, pro, home, and server), each of which is subject to this Agreement. UPON ORDERING, DOWNLOADING, INSTALLING OR USING ANY VERSION OF THE SOFTWARE, YOU ARE REAFFIRMING THAT YOU ARE BOUND TO THE TERMS OF THIS AGREEMENT.

The registered version requires registration with Genie9.com Corp., Which includes payment of the then current license fee. The evaluation version is the only version that is provided without charge; however, the evaluation version is not free software. All rights and licenses to the evaluation version automatically expire 30 days after first installation, after which you must register with Genie9.com Corp. and pay the then current license fee. Payment must be in US dollars drawn on a US bank. For details on registration methods, please refer to the help file in the software, or contact Genie9.com Corp.

License to Use

One copy of the free version of GENIE TIMELINE. The Genie9 Company through this License Agreement grants to you non-exclusive and non-transferable rights there under in respect of using a copy of the computer program for a service life thereof, i.e. for a time period throughout which Genie9 shall maintain and make available an updated version thereof. You may install (download) and use only one copy of the program designated for protection of exclusively one personal computer, notwithstanding as to how many times you download the program and how many times you accept the License Agreement. You must not use the program in a network or on more than one computer. This particular software version is distributed free of charge, therefore, the applicable license is only granted for home use thereof. In case of this free version, the program is not subject to any guarantees, and the user has no right to any technical support whatsoever.

One copy of the evaluation version of GENIE TIMELINE may be used by a single person for evaluation purposes without charge up to 30 days. Subsequent downloads of the evaluation version by or for the same user do not extend, renew, or otherwise restart the term of the license for the evaluation version.

One copy of the registered version of GENIE TIMELINE may be used by a single person who uses the software personally. The registered version of GENIE TIMELINE may not be rented, loaned, leased, licensed, or otherwise used, by anyone other than the individual who has registered the software.

Site licenses for GENIE TIMELINE may be obtained from Genie9.com Corp which cover multiple users at one location or multiple users within a business entity.

You may make a reasonable number of copies of the registered version of the software for backup and archival purposes. You also agree that you may not reverse assemble, reverse compile, or otherwise translate the Program.
No Additional Licenses

All rights to the GENIE TIMELINE software and documentation not expressly granted under this Agreement are reserved to Genie9.com Corp. You may not translate, decompile, disassemble or reverse engineer the GENIE TIMELINE software or documentation.

Costs of Litigation.

If any action is brought by either party to this License Agreement against the other party regarding the subject matter hereof, the prevailing party shall be entitled to recover, in addition to any other relief granted, reasonable attorney fees and expenses of litigation.

Disclaimer of Warranty

THIS SOFTWARE AND ACCOMPANYING DOCUMENTATION ARE PROVIDED "AS IS" AND WITHOUT WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED. BECAUSE OF THE VARIOUS HARDWARE AND SOFTWARE ENVIRONMENTS INTO WHICH GENIE TIMELINE MAY BE USED, NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED. IN PARTICULAR, Genie9.COM CORP SHALL HAVE NO LIABILITY FOR ANY DATA STORED OR PROCESSED WITH THIS SOFTWARE, INCLUDING THE COSTS OF RECOVERING SUCH DATA. THE USER MUST ASSUME THE ENTIRE RISK OF USING THIS PROGRAM. ANY LIABILITY of Genie9.COM CORP. WILL BE LIMITED EXCLUSIVELY TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL Genie9 OR ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, BUSINESS INTERRUPTION, CORRUPTION OF FILES, LOSS OF BUSINESS INFORMATION OR ANY OTHER PECUNIARY LOSS) REGARDLESS OF CAUSE OR FORM OF ACTION, INCLUDING CONTRACT, TORT OR NEGLIGENCE, ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE PRODUCT, EVEN IF Genie9 HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES AND JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY OF CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

LIIMITION OF LIABILITY

Genie9'S ENTIRE LIABILITY AND YOUR EXCLUSIVE REMEDY UNDER THIS END USER LICENSE SHALL NOT EXCEED ONE DOLLAR (US $1.00).

USE OF THIS PRODUCT FOR ANY PERIOD OF TIME CONSTITUTES YOUR ACCEPTANCE OF THIS AGREEMENT AND SUBJECTS YOU TO ITS CONTENTS.

SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES SO THIS LANGUAGE MAY NOT APPLY. IN SUCH CASE, Genie9.COM INC'S LIABILITIES WILL BE LIMITED BY THE ABOVE LIMITATION OF REMEDIES PROVISION.

US GOVERNMENT RESTRICTED RIGHTS

Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subdivision (b)(3)(ii) of the Rights in Technical Data and Computer Software clause at 25 2.227-7013.
What's new

- Internal Deduplication (Machine-Level) to eliminate multiple copies of files stored in multiple locations in the backup.
- The ability to schedule backups on specific date and time and power option modes after backup.
- File Retention specified by size, date, or number of file versions.
- New and Enhanced Interface.
- Improved Backup Speed (2x Faster).
- Folder backup marker to indicate what folders are taken into backup.
- New Disaster Recovery startup engine.
- A simplified backup setup: Removed restrictions on drive selection and easier smart selection.
- Enhanced search engine.

Feature matrix

Genie Timeline is packaged in 4 different versions to meet various markets; Free, Home, Professional, and Server editions. The Server edition only defers from Pro that it supports Server Platforms.

This table demonstrates the differences between the versions:

<table>
<thead>
<tr>
<th>Specification</th>
<th>Free</th>
<th>Home</th>
<th>Pro/Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify smart selection’s file types</td>
<td>×</td>
<td>×</td>
<td>✓</td>
</tr>
<tr>
<td>Security military grade encryption</td>
<td>×</td>
<td>×</td>
<td>✓</td>
</tr>
<tr>
<td>Date based schedule</td>
<td>×</td>
<td>×</td>
<td>✓</td>
</tr>
<tr>
<td>Computer Shutdown after backup</td>
<td>×</td>
<td>×</td>
<td>✓</td>
</tr>
<tr>
<td>File retention by size/days</td>
<td>×</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Frequency based schedule</td>
<td>×</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Minimum interval between each backup</td>
<td>8 hours</td>
<td>30 mins</td>
<td>3 mins</td>
</tr>
<tr>
<td>iPhone/iPad/iPod Backup</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Disaster Recovery</td>
<td>×</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Compression</td>
<td>×</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Power Saving Mode</td>
<td>×</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Game/Movie Mode</td>
<td>×</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Free technical support</td>
<td>×</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Commercial Use</td>
<td>×</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>View Deleted files with a right-click</td>
<td>×</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Add/Remove Files with a right-click</td>
<td>×</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Feature</td>
<td>Yes</td>
<td>No</td>
<td>Optional</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----</td>
<td>-----</td>
<td>----------</td>
</tr>
<tr>
<td>Show Versions with a right-click</td>
<td>X</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>Timeline Explorer</td>
<td>X</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>Backup Markers</td>
<td>X</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>View in Timeline</td>
<td>X</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>Automatic file version purge</td>
<td>X</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>Smart/Turbo modes</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Email Notification</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>iPhone monitor App</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Plug n’ Backup</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Pause/Resume backups</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Force Backup run</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Parallel Block Level</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Deduplication</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Email Backup(Outlook, Outlook Express, Windows Mail)</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Backup Desktop</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Backup Documents</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Backup Pictures</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Backup Music</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Backup Videos</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Backup Bookmarks</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Backup Pdfs and eBooks</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Backup Financial Files</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Backup Office files</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Backup to any drive (local, external, network)</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Restore Wizard</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Restore older backups</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>IntelliCDP</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Easy to use backup setup</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Explorer like file selection</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Backup open and locked files</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Dashboard</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Protection level</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Backup breakdown</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>Search</td>
<td>V</td>
<td></td>
<td>V</td>
</tr>
</tbody>
</table>
### Unavailable features

Genie Timeline is packaged in 4 different versions to meet various markets. Some features might not be available, depending on the product you are using. However, all features are documented. For a feature comparison of the versions, please refer to the [feature matrix](#). If a feature is not accessible in the product user interface, it is likely not included with your version of the product.
Installation

System requirements

- **Hardware**
  - Intel Pentium® IV processor or equivalent and above
  - 512 MB RAM (1 GB RAM recommended)
  - 200 MB free hard drive space
- **Software**
  - Windows® XP, Windows® Vista, and Windows®7 (32 and 64-bit platforms) for Free, Home and Pro versions
  - Internet web browser

Installing Genie Timeline

Installing from the downloaded file:

Run the downloaded .exe file and follow the on-screen instructions to install and setup your first backup.

Registering Genie Timeline

Upon purchasing a Genie Timeline license, the user will receive an email containing a serial number for unlocking the software and removing the trial period limitation.

To register Genie Timeline:

**Method 1:**

1. From the Dashboard, Go to **Tools** > **Product Info** > select **Enter Serial Number**
2. Type or copy-paste the serial number into its designated field then click OK.

**Method 2:**

1. When the Trail Period countdown pops up, select Enter Serial Number.
2. Type or copy-paste the serial number into its designated field then click OK.

**Method 3:**

1. When the Expire Period dialog pops up, select Enter Serial Number.
2. Type or copy-paste the serial number into its designated field then click OK.

---

**Updating Genie Timeline**

Genie Timeline will check for latest enhancements and patches released by developers on a weekly basis. If a new build is available a system tray pop-up will notify the user of the new build.

To update Genie Timeline:

1. Once an update is available, a pop-up will show notifying the user that there is a new build, click Update Now.
2. Genie Timeline will download the update and the setup wizard will appear, click Next.
3. Select Repair/Update and click Next.
4. Follow the on screen instructions to complete updating.

**Note**

To disable checking for updates, go to **General Preferences**.

---

**Upgrading from the previous version**

Genie Timeline 2012 comes as a separate installation; however, the previous backup will automatically resume as normal without any configuration required.

To Upgrade:

1. Run the Genie Timeline setup.
2. Select **Upgrade to version 2012** This will uninstall Genie Timeline version 2.1 and install the Genie Timeline 2012.

**Uninstalling Genie Timeline**

Uninstalling Genie Timeline can be performed from:

**Method 1 performed by:**

1. From the start menu go to Genie9> Genie Timeline Tools.
2. Click Uninstall.
3. The uninstall Wizard will appear > Click Uninstall.
4. After the process finishes, click Close.

Method 2:

1. Double click the Genie Timeline Setup file.
2. Click Next.
3. Select Uninstall Genie Timeline.
4. Click Next.
5. Click Uninstall.
6. After the process finishes, click Close.

Method 3:

1. From Control Panel > Go to Add or Remove Programs (XP) or Programs and Features (Vista and above).
2. Select the Genie Timeline and click Uninstall.
3. The Uninstall Wizard will appear > Click Uninstall.
4. After the process finishes, click Close.

Note

Uninstalling Genie Timeline will erase the backup settings but not the actual backup; however, you cannot resume your old backup, to keep your old backup settings, use the Repair/Update function in Method 3.
**Genie Timeline basics**

**What can Genie Timeline do?**

Genie Timeline offers real time backup for all your critical files in an easy to use setup. Just follow a simple 3-step wizard to configure your backup and all your data will be protected with Genie Timeline.

Genie Timeline is a parallel universe of your computing history, deleted and modified files can be retrieved easily by a click of a button. You can browse the Timeline to any desired date to restore data.

Genie Timeline Can

1. Backup your system: Genie Timeline will backup your Windows folder, Program files, User folders, and System State for complete system protection
2. Backup your important data: Backs up Emails, Documents, Desktop, Office files, eBooks, Bookmarks, Pictures, Videos, Music, and iPhone/iPad/iPod synced files.
3. Track changes occurred to files constantly and backup files at a specified time interval if the backup destination is accessible.
4. Resume backing up the same file after powering off the system, without restarting the backup process.
5. Backup outlook email files (PST) using dynamic block level incremental.
6. Shows frequent backups for the past 4 hours, hourly backups for the past 48 hours, daily backups for the past week, weekly backups onwards.
7. Automatically deletes old files that are not showing on Genie Timeline to free space.
8. Offers security and compression options for backup.
9. Restore all data or selected data from the backup.
10. Recover your system from disasters via Disaster Recovery option.
11. Restore deleted files that are in the backup.
12. Detect and restore deleted files by right-clicking its original location.
13. Show versions of files backed up.
14. Run in several performance modes for faster or slower backups.
15. Restore data from an old archive.
16. Creates only one job at a time and closes the old one for archiving purposes.
17. Backs up local and remote locations.
18. Stops backups while playing games, watching movies, or displaying presentations.
19. Runs on low resources when your computer is running on batteries, stops when power level is low.

**When are your files protected?**

By Default, Genie Timeline will run in IntelliCDP mode. This mode will run as an adaptive Continuous Data Protection (CDP) approach, where small files that constantly change will be backed up more often than larger files, unless set by user. If the drive is reconnected after a backup was missed, it will automatically run without any intervention. Users also have the option to schedule backups to run on a specific time and day or every couple of hours.

**Notes**

- The IntelliCDP varies based on the version. On the Pro and Server versions, it will run every 3 minutes, while in the home version it will run every 10 minutes, and the free edition will run every half hour.
- To change when Genie Timeline takes backups, go to Schedule the backup section.
Protecting open files

Genie Timeline does not require users to close their open and locked files including emails, web browser bookmarks, databases, etc...

If Genie Timeline finds a file locked by another program, it automatically activates the Open File backup component, which utilizes Microsoft's Volume Shadow Copy framework to backup the open file even while working on it.

File versions

On specific time intervals, an incremental backup of your data is made automatically as long as your backup drive is attached to your Device. Genie Timeline saves backups for the past 4 hours, hourly backups for the past 48 hours, daily backups for the past week, and weekly backups onwards, files created and then deleted before the next backup will not be included. When your backup drive becomes full, Genie Timeline will automatically delete old versions of files not showing on Timeline to free space.

If you delete a file that has been backed up

Files that have been deleted off the hard disk will not be deleted from Genie Timeline. Therefore, an accidentally deleted file can be recovered from backup ensuring protection of all data.

The recovery of deleted files can be done by

- The context menu
- Timeline Explorer
- Advanced Restore
- Search backup

Deleting files from the actual backup

When the drive starts running out of free space. Genie Timeline will start deleting older versions of files that do not show on Timeline to clear out space. There is no need to initiate the process as it will run silently, automatically, and without prompting.
Genie Timeline User Manual

Note:

- To customize purge options to limit backup by size or file versions, please go to Customize Backup
- This feature is not supported for the free version

Backup changed and modified files

Each time Genie Timeline runs; new, modified, and changed files will be added to the backup. Small files will be taken as a whole file, for faster restoration. However, large modified files will be backed up using Genie Block level incremental. This Technology is ideal for large files that undergo slight changes like databases, Outlook email files (PST) and so on. In this type of backup only changes within the file will be backed up and not the entire file, saving more space and time.

Files with major changes will be taken into the backup as a full file for faster recovery of that file.

![Diagram showing backup process]

Note

In this version, only Outlook PST file types will be backed up using Genie Block Level Incremental technology.

If the backup is interrupted
Backups can be interrupted in the following cases:

- The computer is powered off suddenly or by user action.
- The backup destination is disconnected.
- The user paused the backup.

In all cases, Genie Timeline will resume where it left off without the need to restart the backup process.

**Smart Selection vs My Computer**

Genie Timeline divides data backed up into two groups; Smart Selection and My Computer. The following table shows the major differences between the two groups.

<table>
<thead>
<tr>
<th>Definition</th>
<th>Smart Selection</th>
<th>My Computer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Contains various built-in plugins that you can use to backup some of the most important items on your computer</td>
<td>Allows you to backup files and folders from any location readily accessible from My Computer using an easy to use Windows Explorer-like interface.</td>
</tr>
<tr>
<td>System dependency</td>
<td>Plugins are system independent, i.e. users can backup favorites, for instance, from a Windows XP machine and restore them on a Windows Vista machine, without having to worry about the changed Windows environment</td>
<td>System dependent, it will restore to the same path it was taken from</td>
</tr>
<tr>
<td>Purpose</td>
<td>Easy to use, backs up data by type, even if user is unaware of file location</td>
<td>A complete view of all files/folders stored on the computer to be included in backup</td>
</tr>
</tbody>
</table>

**Notes**

- If a file is selected from both Smart Selection and My Computer, it will only be backed up once.
- Smart Selection contains the preselected data for Genie Timeline. To modify, add, or remove the data, click on **Customize selections**.
- The My Computer tab is supported only when running under an Administrator user account.

**Multiple copies of the same file**

If you have multiple copies of the same file scattered amongst multiple locations, Genie Timeline's Machine-Level deduplication is smart enough to only take one copy and link them to the other locations. Therefore, you will be able to recover the file to all its locations.

Note: Machine level deduplication works on encrypted drives, such as drives encrypted with TrueCrypt or Windows encryption

**Security**
Genie Timeline offers an enhanced level of protection to ensure that backed up data is not accessible to unauthorized persons. With 256 AES (Advanced Encryption Standard) encryption the data backed up is highly secure, as this encryption method is adopted by NIST (National Institute of Standards and Technology) as an FIPS-approved (Federal Information Processing Standard) symmetric encryption algorithm that may be used by U.S. Government organizations (and others) to protect sensitive information.

Compression

Genie Timeline uses nonproprietary 64-bit ZIP compression to compress each file individually. This feature enables up to 8 terrabyte files to be protected using Genie Timeline.

Backup drives

Genie Timeline aims for system protection. Therefore, it is recommended to select a Hard drive that is accessible and contains sufficient space, external or a network storage device is preferred.

What happens if your drive becomes full/inaccessible

If the drive becomes full

Home and Professional versions of Genie Timeline will purge/consolidate older backups to save space. Older Backups are collected into fewer ticks on the Timeline, so the timeline will show frequent backups for the past 4 hours, hourly backups for the past 48 hours, daily backups for the past week, weekly backups onwards.

When the drive’s free space is low, Genie Timeline automatically deletes old versions of backed up files to free space. However, if Genie Timeline is unable to find old versions to delete, the backup will stop when there is 500MB of free space left. Genie Timeline will update the interface to show that the drive needs to be replaced.

What triggers purging?

Timeline will purge/consolidate older versions of your files:
1- You are running low on space: If Timeline finds that there is not enough space on your drive to continue the backup, all versions, except the original and latest, that were created up to where the backup stopped will be deleted to make room for newer versions of files.

2- Daily purge: Older backups will be collected into fewer ticks on the Timeline, these ticks represent versions of files created at a specific time. Timeline will delete specific files that represent the ticks that have been collected throughout the day.

If the drive is inaccessible

Users may tend to disconnect the drive; therefore, the backup will stop, but will not display the warning unless an action has not been taken within 7 days. If the same drive is inserted, even if the drive letter has changed, Genie Timeline will resume backup without any user intervention.

Note

Replacing your drive immediately after it becomes full is highly recommended to be fully protected.

Inserting an external hard drive

Genie Timeline is smart enough to know what drive it is currently backing up to even if the drive letter has changed. Therefore, if the drive is reconnected, Genie Timeline will resume automatically without user interaction.
### Configuring your first backup

**Configuring your first backup**

After installing the product, the setup wizard will appear with a 3-step process to configure the backup. If a user needed to reboot before setting up the backup, the setup wizard can be accessed by:

1. Double-click the [System Tray Agent](#).
2. From Start > All Programs > Genie9 > Genie Timeline.

**Note**

Users can restart the backup process by accessing the [Dashboard](#) > [Start a new backup](#) under Manage Backup section.

### Setup wizard

**Setup wizard**

The Setup Wizard consists of 3 steps depending on your version:

- **Select Backup Drive**: A list of backup destinations with recommendations on where to backup. It is recommended to backup to an external drive with efficient amount of free space for more reliability.
- **Select Data**: Keep the preselected data or select the data you wish to protect, the most important selections will be viewed in the first tab "Smart Selection" and further selections are accessed from the "My Computer" tab.
- **Set Backup Options**: Specify to compress and/or encrypt the data and set the encryption password.

**Notes**

- Security, compression, and backup drives will not change unless the backup job resets; by closing the existing backup and [start a new full backup](#).
- The encryption password is case sensitive and should be provided "AS IS", if you lose or forget the password your encrypted data will be irretrievable.

### Select Backup Drive

Genie Timeline recommends that all data is stored in a safe, removable location for storage purposes.

To select a backup drive:
1. From the Setup Wizard, click start here.
2. Make sure the drive you wish to backup to is connected and accessible.
3. Select a drive or click Select a different destination to browse for a specific folder location
4. Click next to proceed.

**Notes**

- If your backup location is not showing or wish to designate the backup to a specific folder, click on Select a different destination and browse for the desired location.
- If a drive is not showing in the list, try refreshing by clicking the refresh button located under the drive list.

**Select Data**

Select Data

Genie Timeline preselects the most important data to backup on your System. Users have the ability to uncheck or check what they want to backup.

In the "Smart Selection" section, users have the option to select predefined data groups; "Smart Selection" that backs up most important items on your computer. This includes Emails, Favorites, Desktop files and folders, etc.

Data selections consists:

**Smart Selection:** Predefined selections of important data groups.

- Disaster Recovery Files
- Outlook Profiles
- Outlook Express or Windows Mail
- Windows Live Mail
- Desktop
- My Documents
- Pictures
- Music Files
- Video Files
- Office Files
- iPhone/iPad/iPod files synced through iTunes
- Financial Files
- eBooks and PDFs
- Bookmarks
- Miscellaneous
**My Computer:** Browse and select any file or folder stored on the computer using the same structure as Windows Explorer. Users can exclude certain file extensions from My Computer selections using file filtering.

**See Also**

- File types backed up via Smart Selection
- How to modify selections

**File types backed up in Preselected Data and Smart Selection**

Genie Timeline backs up the following file types for each Data profile:

- **Disaster Recovery:** This will backup the Windows folder, Program Files, Program's data, and User folders, every 7 days.

- **Outlook:** Genie Timeline scans for Personal Folders Files (PST).

- **Outlook Express:** Backup email files for Outlook Express in all identities; (.dbx) files, and Windows Address book (.wab).

- **Windows Mail:** Backup email files (.eml), stationery, community, account (oeaccount) and rules for Windows Mail and Windows Contacts (.contact).

- **My Documents, Documents, and Desktop backup all files located in these locations.**

- **Pictures:** Scans for these file types in your personal folder (Desktop, Documents, and Pictures folder)

  * .bmp;*.jpg;*.jpeg;*.jpe;*.gif;*.tif;*.tiff;*.png

- **Music Files:** Scans for these file types in your personal folder (Desktop, Documents, Music and Downloads folder)

  * .wmd;*.wma;*.mp2;*.mpa;*.mp3;*.rmi;*.aif;*.aiffc
  * .aiff;*.rt;*.rm;*.ram;*.ra;*.rp;*.mpga;*.aac;*.wav
  * .flac;*.m3u;*.m4b;*.pls;*.m4a

- **Video Files:** Scans for these file types in your personal folder (Desktop, Documents, Videos and Downloads folder)

  * .wmv;*.mov;*.mpeg;*.mpg;*.3g2;*.3gp;*.asf
  * .3gpp;*.asx;*.flv;*.mkv;*.mp4;*.mpg;*.ogm;*.qt
  * .mpe;*.m1v;*.mpv2;*.mp2v;*.rmvb;*.m1v;*.mqv;*.rv

- **Office Files:** Scans for these file types in your personal folder (Desktop, Documents)

  **Word and Text Files**
Configuring your first backup

*.doc;*.docx;*.dot;*.dotx;*.docm;*.dotm;*.txt
*.rtf;*.wri;*.abw;*.odt;*.ott;*.stw;*.vor;*.sdw
*.fodt;*.psw;*.vot;*.sxw;*.lwp;*.wpd

Presentations Documents

*.ppt;*.pps;*.pot;*.pptx;*.pptm;*.potx;*.potm
*.ppam;*.ppsx;*.ppsm;*.ppa;*.odp;*.otp;*.sxi
*.sti;*.sxd;*.sda;*.sdd;*.vop;*.odj;*.prz;*.shw

Spreadsheets

*.xls;*.xlsx;*.xlsb;*.xltx;*.xltm;*.xla
*.pml;*.lwp;*.wpd;*.vos;*.vot;*.qpf;*.wk1;*.wk3;*.wk4

Database Files

*.mdb;*.mdw;*.mda;*.adb;*.ade;*.accdb;*.accde
*.accdt;*.accdr;*.odb;*.apr;*.odf;*.sxm;*.fods

Visio

*.vsd;*.vss;*.vst;*.vdx;*.tsx;*.vtx;*.odg;*.otg
*.std;*.fodg

Publisher

*.pub

Project Files

*.mpp;*.mpd;*.mpt;*.mpw;*.mpx

Financial Files: Scans for these file types in your personal folder (Desktop, Documents)

Microsoft Money

*.mny

Quickbooks

*.qbb

Quicken

*.qbw;*.qel;*.qsd;*.qph

TurboTax

*.tax
iPhone/iPad/iPod: Backup files synced to your computer through iTunes.

Bookmarks: Backs up bookmark location from a variety of browsers

- Internet Explorer: Located in Favorites folder
- Mozilla Firefox: Located in the application data folder for Firefox
- Opera: Located in the application data folder for Opera or installation path
- Google Chrome: Located in the local application data folder for Google
- Apple Safari: Located in the application data folder for Apple Computer

EBooks and PDF files: Scans for these file types in your personal folder (Desktop, Documents)

- azw;*.tpz;*.azw1;*.chm;*.lit;*.pdb;*.pdf;*.mobi;*.prc;*.tr;*.tr2
- tr3;*.fb2;*.opf;*.aeh;*.lrf;*.lrx;*.epub;*.pdg;*.pkg;*.dnl;*.djvu;*.arg
- .bfl;*.bkk;*.brn;*.ceb;*.ebk;*.ebo;*.ebx;*.etd;*.f4b;*.hsb;*.imp;*.mbp
- .meb;*.nat;*.oeb;*.rb;*.scb;*.skn;*.stk;*.swb;*.tcr;*.tk3;*.ubk;*.vbk
  - .xebr;*.ybk;*.zvr

Miscellaneous: Scans for these file types in your personal folder (Desktop, Documents)

- .rar;*.zip;*.iso

Note

Users can edit, add, or remove the file types from the edit button located on each profile.

Mobile Device Backup

From the Smart selections you can ensure that your mobile data is safe by choosing to backup your:

iPhone/iPad/iPod:
Configuring your first backup

Genie Timeline backups the data that you have synced to your computer from your iPhone, iPad, or iPod via iTunes.

To backup your device:

1. Open the Dashboard > from Manage Backup > Select Modify data selections
2. Select iPhone/iPad/iPod
3. Click save to save changes

Note

- Genie Timeline cannot detect any changes or additions to files on your iPhone/iPad/iPod unless they are synced through iTunes first.
- The restore will basically restore these files to their locations on your computer. You will need to restore them back to your device for full recovery.

Modify Smart Selections

Method 1:

1. From Step 2 of the Setup wizard Select Data page will appear.
2. From Step 2 of the Setup wizard Select Data page will appear.
3. Mark the selections from Smart Selection.
4. Click next to proceed with the wizard.

Change File types in Smart Selection

1. From Step 2 of the Setup wizard Select Data page will appear.
2. Click the edit link in the profile, a dialog will appear with the current file types
3. Edit the file types, with a semi-colon separator ";" and a dot "." before each extension (for example: ;.html).
4. Click save to save changes, cancel to cancel, or reset to reset to original file types.

My Computer tab

Adding items from My Computer tab

Genie Timeline gives a Windows-Explorer-like view to manually select any file/folder location for backup.

To select files/folders from My Computer tab

Method 1:
1. From Select Data click Customize selection.
2. Click on My Computer tab.
3. Browse to the folders/files you want to backup and select them. Selecting the entire folder and its contents will have a blue check, partial folder selections will have a grey check.

**Notes**

- The My Computer tab is supported only when running under an Administrator user account.
- To Exclude specific file types, use Filter my selections.
- To Show hidden files in My Computer tab, enable Show hidden files in My Computer tab during data selection from Windows Explorer Enhancements preferences.
- Selecting a folder and then excluding items under it means that newly added items will be automatically added to backup.
- Selecting items under a folder first means that newly added items under this folder will not be added to backup.

### Title

**Creating File Filters**

Users can exclude specific file types of selected items from My Computer tab. To create file filters, please do the following:

1. Select My Computer tab.
2. Click Filter my Selections.
3. Select Enable Filters.
4. Under Exclude files that end with the following extensions, type the file extensions separated by semi-colons for multiple file selections (example .html;.exe;.dwg).
5. Click Done to save changes.

**Note**

Filters must be entered without any wildcard (i.e. .txt).

### Set Backup Options

In this part of the backup setup, users can choose to compress their data using 64-bit Zip compression and encrypt via highly secure 256 bit AES military encryption.

**To Enable Compression**

1. In the Setup wizard go to Step 3.
2. Mark the Checkbox Enable Compression.
3. Click next to proceed.

**To Enable Security**
1. In the Setup wizard go to Step 3.
2. Mark the checkbox Enable Encryption.
3. Type the Encryption password and retype the password for confirmation, it is recommended to select a strong Encryption Password for better protection.
4. Click next to proceed.

**Notes**

- Encryption and compression cannot be disabled for a single backup as it causes security vulnerabilities, encryption can only be enabled or disabled if the user creates a new backup.
- The encryption password at time of viewing or restoring encrypted data must be supplied "AS IS". Genie Timeline does not save this password. Without supplying this password, users' data is irretrievable; therefore, please store it in a safe place.
How to

Modify data selections

Users can change, add, or remove data selected for backup without the need to start a new backup.

To Modify Data Selections

1. Open the Dashboard.
2. Under Manage Backup, select Modify data selections.
3. Select Customize selections.
4. Check the data you wish to protect.
5. Click save to save changes.

Notes

- Un-selecting data will not delete it from the backup.
- To edit a data profile's file types, click edit in the right hand corner of the profile. Only profiles that can be edited will have this capability.
- Filtering file extensions from My Computer can be achieved by using file filtering.
- Click Revert to pre-selected data to cancel selections and take all smart selections.
- To backup hidden files and folders under the My Computer tab, make sure it is enabled by selecting Show hidden files in the My Computer tab during data selection located under Windows Explorer Enhancements preference.

Select files/folder from My Computer tab

Genie Timeline gives a Windows-Explorer-like view to manually select any file/folder location for backup, including external and network locations.

To select files/folders from My Computer tab

1. Open the Dashboard.
2. Under Manage Backup, select Modify data selections.
3. Select Customize selections.
4. Check the data you wish to protect.
5. Click save to save changes.

Notes

- The My Computer tab is supported only when running under an Administrator user account.
- To Show Hidden files in the My Computer tab, enable Show hidden files in the My Computer tab during data selection from Windows Explorer Enhancements preferences.
- Selecting an entire folder means that newly added items will be included into backup.
- Selecting a folder and then excluding items under it means that newly added items will be automatically added to backup.
- Selecting items under a folder first means that newly added items under this folder will not be added to backup.
• You can cancel selections and go back to pre-selected data by clicking on Revert to pre-selected data.

**Change backup drive**

Genie Timeline recommends that all data is stored in a safe removable location for storage purposes.

1. Open the **Dashboard**.
2. Under Manage Backup > click Change backup drive.
3. Select the backup Location.
4. Alternatively, select "Select a different destination" if you wish to browse for a specific folder.
5. Click save to save the new location.

**Note**

When changing the backup drive, the backup will restart. You can keep your older backup for archiving purposes.

**Schedule Backup**

Backup Schedule is located under Tools > **Advanced Settings** in the **Dashboard** and enables users to set when Genie Timeline should perform backups.

Users can either choose one of the following scheduling modes

- **Use Genie IntelliCDP**: This mode will run as an adaptive Continuous Data Protection (CDP) approach, where small files that constantly change will be backed up more often than larger files.
- **Use a specific backup interval**: All files will be taken at the same interval set in the combo box.
- **Run on Schedule**: Set at what time and day(s) for the backup to run. Users also have the option to shutdown, sleep, or hibernate the computer via after Genie Timeline completes option

To Schedule the backup to run at a specific interval

1. Open the **Dashboard**.
2. Under **Tools**, select **Advanced Settings**.
3. Select **Backup Schedule**
4. Select **Use a specific backup interval**, use the combo-box right by **Run every** to select the exact interval.
5. Click **ok** to save

To Schedule the backup to run on a specific time and day(s)
1. Open the **Dashboard**.
2. Under **Tools**, select **Advanced Settings**.
3. Select **Backup Schedule**
4. Select **Run on Schedule**, select the time and days you wish to run the backup on.
5. Click **ok** to save

### Change Advanced Backup Settings

To change advanced backup settings and preferences navigate to Tools > **Advanced Settings** in the **Dashboard** and enables users to adjust the following:

**Customize Backup**: Set file retention and enable game, movie and power saving mode.

**Backup Schedule**: Set schedule when Genie Timeline should run backups.

**Email notifications**: Enable email notifications of the status of your backup to be sent to your inbox.

**Genie Timeline App**: Enable and download Genie Timeline App to your iPhone or iPod touch for a live monitor of the status of your backup.

**Preferences**: Global preferences of Genie Timeline, such as receiving live updates, auto-exclude, and windows explorer enhancements

After configuring these settings, click **save** to accept changes.

**Note**

- The Advanced settings must be re-configured if a user recreates the backup or changes the backup drive

### Customize Backup

Customize Backup is located under Tools > **Advanced Settings** in the **Dashboard** and enables users to adjust the following:

**Enable File Retention**: This specifies when Genie Timeline starts deleting file versions either by limiting the size of backup on the drive or by days.

**Enable Game/Movie mode**: When this option is selected, Genie Timeline will pause the backup and suppress pop-ups when playing games, watching movies, or displaying presentations.

**Enable Power Saving mode**: Only available on laptops, when the PC runs on batteries, Genie Timeline will reduce its resources to save battery. If the battery level reaches critical, the backup will stop.
After configuring these settings, click save to accept changes.

**Note**

- These settings must be re-configured if a user recreates the backup or changes the backup drive

**Configure email notifications**

This option will send reports of the backup status directly to the user's Inbox.

**To Email the backup status**

1. Open the Dashboard.
2. Under Tools, select Advanced Settings.
3. Select Email notifications
4. Select Email me backup status.
5. Under Notification Schedule, select one or both options.
   - Send Every
     This will send a backup status on a specific day of the week.
   - Send when an error occurs
     Send an email when there is an error; the backup destination is full, it has been several days since the last backup, or failed files for backup.
6. Under Email Server Settings users can send emails via one of the following methods:

5. 1. Use Genie's email service
    Let Genie9 send email notifications using the Genie email service. Register for free to create a Genie Account (My Account) and enable this service. A confirmation email will be sent with the registration information. Then enter the following:
       - Email: The email address used to create a free My Account.
       - Password: The password sent in the confirmation email.
   2. **Use My own email server**
      Enter the following information
      
      - SMTP server: The name or IP address of SMTP server to be used for sending notification emails.
      - Port: SMTP sending port. (25 by default).
      - My email: The email address to receive notification emails.
      - Use SSL: SSL (Secure Sockets Layer) is a security protocol that provides communication privacy. Select this option if your SMTP server supports this protocol.
      - Select My email requires authentication, and enter:
        - Username: Email account username.
        - Password: Email account password.

7. Click Send test email to send a test email using these settings.
8. Click save to save changes.

**Genie Timeline Monitor**
The Genie Timeline monitor is a Free iPhone App that keeps you informed of the latest protection status of your backup.

To enable the monitor

1. Open the Dashboard.
2. Under Tools, select Advanced Settings.
3. Select Genie Timeline App
4. Select Enable Genie Timeline App
5. Enter your email address and click Generate PIN
6. After generating the PIN, click on the Available on iPhone App Store to download the app to your iPhone, and enter your email and PIN to activate.

Create Disaster Recovery startup disk

In order to restore Windows and data if Windows no longer loads, users are required to create a Disaster Recovery startup disk to startup the system in Disaster Recovery mode.

Two options are available to create a startup disk:

- USB Disk: Enter Genie Disaster Recovery using an external drive or flash disk.
- ISO Image: Create an ISO image, which you can burn onto a CD or DVD and boot from to enter Disaster Recovery.

To create a USB startup disk:

1. From the Dashboard > Under Tools> Select Disaster Recovery startup disk, the Disaster Recovery Media dialog will appear.
2. Select USB Drive.
3. From the drop-down list, select the USB disk.
4. Click ok to begin the process.

To create an ISO image:

1. From the Dashboard > Under Tools> Select Disaster Recovery startup disk, the Disaster Recovery Media dialog will appear.
2. Select ISO image.
3. Browse for a location to save the ISO image.
4. Click ok to begin the process.

Notes

- The creation of a startup disk requires 1-3 minutes to complete.
- It is recommended to use an erased or blank disk as Genie Timeline will erase all contents before creating the startup disk.
Start a new backup

Genie Timeline, for simplicity purposes, will only enable running one backup job at a time. Therefore, creating a new backup job will close the currently running backup and open the Setup Wizard. The old backup can be stored for archiving purposes.

To start a new backup

1. Right click the system tray > Select Open Dashboard.
2. Under Manage Backup click Start a new backup.
3. Click Yes to confirm creating a new backup and the Setup Wizard will appear to configure a new backup.

Restoring from an older backup

Every time a user chooses a new destination to backup to, the old backup database is closed and the active one is the default view in Advanced Restore and Timeline Explorer. Restoring from an older backup can be done from the Advanced Restore.

To restore from an older backup

1. Open Advanced Restore from the Dashboard.
2. Browse for the drive/destination that has the older backup, or browse for the "_Genie Timeline" folder.
3. If there is more than one backup on the drive/destination, Genie Timeline will load the backups that are on the location to select from the list.
4. Move the Timeline slider to select the time frame to restore data from.
5. Expand the folder structure to browse for the files and folders needed to be restored.
6. Select the files, blue check marks indicate that all files and folders are selected, grey indicates partial selection.
7. Select the data you wish to restore.
8. Click next to proceed to restore options.

Notes

- When encryption is enabled, you will be prompted to enter the encryption password before proceeding to the Restore Options.

Searching the Backup

Users have the option to search files in the backup using the entire file name or part of it:
Method 1:

1. Open the Dashboard.
2. Type in the search term in the search backup text-box located at the right corner of the Dashboard.
3. Press Enter or click the search icon.

Method 2:

1. Open Advanced Restore.
2. Type in the search term in the search backup text-box located in the bottom-left side of the page.
3. Press Enter or click the search icon.

Method 3:

1. Right-click the system tray agent.
2. Click Search.
3. Type in the search term and press enter or click on the search icon.

Notes

• When encryption is enabled, users will be prompted to enter their encryption password when opening a file.
• The search will only display files in the active backup, backups that are located on different locations can be viewed/restored via Advanced Restore.

Retrieve deleted files that have been backed up

Genie Timeline enables users to display a list of deleted files that are backed up with a simple click

To Retrieve deleted files

1. Open the location of the deleted file.
2. Right click in an empty location.
3. Select View all Deleted Files.
4. A list of deleted items will appear, point to the deleted file, and select the version you wish to restore.
5. Click Restore this version and the file will restore to the location it was deleted from.

Notes

• You can restore deleted items from the Timeline Explorer and Advanced Restore.
• When encryption is enabled, you will be prompted to enter the encryption password when restoring.

Disaster Recovery

In order to restore your system files and settings to a previous state, you will need to:
How to

1. Make sure Disaster Recovery is selected on the Smart Selections page.
2. Create or prepare your Disaster Recovery startup disk.
3. Restart your computer and boot from the Disaster Recovery startup disk to enter the Disaster Recovery wizard.

The Disaster Recovery selection will backup your entire System Drive which includes the following folders every 7 days:

- Windows Folder
- Program Files
- User Folders
- System State

To Provide up to date complete system protection in case of failure.

**Note**

Disaster Recovery is not supported for standard or limited users. Please login to an administrator account to create a Disaster Recovery backup.

**Open current location in Timeline Explorer**

One of Genie Timeline's Windows enhancements is to enable users to open any folder in Windows and view it in Timeline.

To open a folder location in Timeline

1. From My Computer/Computer browse for the location you wish to view in Timeline.
2. From Windows Explorer's address bar, click Explore Timeline. Timeline Explorer will open the folder location.

**Add items to backup from context menu**

To add data to backup directly from Windows

1. Go to the file or folder you wish to add to backup.
2. Right click the item.
3. Go to Genie Timeline and select Add to backup.
Show versions of backed up files

Genie Timeline enables users to view versions of a backed up file.

To show versions of backed up files

Method 1:

1. From My Computer, right-click the file.
2. Point to Genie Timeline.
3. Select Show Versions.
4. To restore a version, select it from the list and click Restore.

Method 2:

1. From Timeline Explorer, right click the file.
2. Select Show Versions.
3. To restore a version, select it from the list and click Restore.

Exclude files from backup

There are various means for excluding files or locations from backup. Only the first method will actually delete all file versions from the backup, the latter methods will only exclude newer versions from being added.

Method 1:

Right click a file/folder> Point to Genie Timeline> Exclude from backup. This will also delete all version of the file in backup.

Method 2:

Drag drop files to No-Backup Zone located on the Desktop.

Method 3:

Modify data selections, and add file filtering options, or Customize smart selections.

Method 4:
How to

Auto-Exclude to exclude full file and folder paths.
Genie Timeline Dashboard

The Dashboard enables users to monitor the health of the backup as well as offering backup controls and settings.

To Access Dashboard

Method 1:

1. Right-click the System Tray agent.
2. Click Open Dashboard.

Method 2:

Double-click the System Tray agent.

Dashboard information

Users can clearly view the following information to check on the health of the backup

Protection Level

Genie Timeline informs users of the status of the backup with the new protection level feature. This feature enables users to keep track of the process of their backup by showing the percentage of protected files. 100% means that all files are protected, there is nothing to backup, and 0% denotes that there are no files protected. When the protection level drops under 60%, it will show as a warning that the protection level is low. The Protection level decreases if:

- New files were added to backup and they are still not backed up.
- Significant file changes occurred between backups.
- The backup is not working because Genie Timeline is paused, backup drive is inaccessible, or insufficient free space.

Status

This section shows:

- What Genie Timeline is backing up or doing at that moment.
- When the last backup occurred.
- When the next backup will run.
- The first date you started protection.
- Compression and security information.

- Free space of the drive and if it is necessary to take action in changing the drive.
- Number of files taken into backup and pending files for the next run.
Backup Breakdown Bar

A bar that shows how the major file types distribute in the backup. Clicking on this line will show the Backup Breakdown.

Backup Breakdown

A distribution of file types in the backup. For each file type, the total size, number of files, and percentage of backup is displayed.

**Backup controls and options**

From the Dashboard, users can manipulate and adjust their backups with the following controls.

"Run backup" controls

**Run now:** Force a backup to run at any time.

**Run in Turbo Mode:** Selecting this mode will enable the backup to run faster by using more computer resources.

**Run in Smart Mode:** Selecting this mode will optimize Genie Timeline's resources to run the backup faster or slower based on how the computer resources are utilized, and will adjust its speed based on free resources; faster backups when computer is idle, slower backups when you are working.

**Pause Backup:** Do not run backup for the time being. Genie Timeline will resume backup automatically after a Windows reboot.

**Resume Backup:** Let backup run.

Restore, manage backup, and tools

In this section, users can take action in:

**Restoring backups**

This can be performed from:

- [Restore from Timeline]: Opens the Timeline Explorer that allows users to go back in time to view and restore backed up files.
- [Advanced Restore]: Step by Step Wizard to restore files and older backups.
- [Disaster Recovery]: A dialog that explains how to recover your system in case of disasters.

**Manage Backups**

Under this section, users can:

- [Modify data selections]: Add, Modify and remove files from backup. This will not restart the backup and will not delete removed selections from backup.
• **Change backup drive**: Change backup drive location. This action will restart the backup with the currently selected data and backup options.
• **Start a new backup**: Create a completely new backup.

**Tools**

• **Change Advanced Settings**: Set file version retention, enable game/movie mode, battery saving mode, set email notifications, enable backup monitor app, set backup Schedule, and access **Preferences**.
• **Create Disaster Recovery Startup Disk**: Install and uninstall the Virtual Partition, create a USB startup disk, or an ISO image to boot into system recovery.
• **Product info**: Display product version and license key.

**Search Backup**

From the top-right corner of the Dashboard, users can search all or part of a file name included in the backup. A web browser page will open with search results.

**Preferences**

**Preferences**

Preferences enable users to:

1. Enable Advanced logging for debugging purposes.
2. Enable/Disable Auto-Update.
3. Auto Exclude Specific File/Folder paths.

To Access Preferences:

1. Open the **Dashboard**.
2. From **Tools** > go to **Advanced Settings** > Click on **Preferences**.

**General**

The General page of the **Preferences** window provides means to set:

**Auto update**

This will enable Genie Timeline to check Genie9's servers for latest enhancements or patches of the software.

**To disable updates:**

• Under Auto update select Disable auto update.

**To enable updates:**

36
• **Under Auto update, select Check for updates on a weekly basis.**

Enable Advanced Logging

Advanced logging will give a trace of the software's activity used for troubleshooting purposes by the Genie9 technical support team.

1. Select Enable advanced logging for debugging.
2. Click Open advanced logs folder.
3. Click OK to save changes.
4. Replicate the scenario and send the logs.

**Auto-Exclude**

The Auto-Exclude page of the Preferences window contains settings for automatically ignoring specific files and folders during backup.

Some system files and folders on the computer are not designed to be taken by Genie Timeline manual file selection. Disaster Recovery is designed to handle these files.

**To Enable Auto-Exclude**

1. From Preferences> Go to Auto-Exclude.
2. Select Enable Auto-Exclude (Recommended).
3. Click OK to save changes.

**To exclude hidden files from backup**

This option will only apply on backing up hidden files selected from My Computer.

1. Select Exclude hidden files.
2. Click OK to save changes.

**To add files/folders to Auto-Exclude**

1. Click Add.
2. Type the file/folder path of the item and description (optional).
3. Click Done.
4. Click OK to save changes.

**To remove files/folders from Auto-Exclude (not recommended for pre-generated auto-exclude items):**
1. Select the File/Folder path.
2. Click Remove.
3. Click OK to save changes.

Notes

- You must enter the full path of the folder/file needed to be excluded.
- Use filters to exclude file types from backup.

Windows Explorer Enhancements

From the Windows Explorer Enhancements page of the Preferences window users can:

- Enable/disable the Timeline Explorer.
  By selecting/un-selecting Show Timeline Explorer in My Computer.

- Show/hide Genie Timeline options in the right-click menu of Windows Explorer.
  By selecting/un-selecting Show Genie Timeline options in context menu.

- Show/hide backup markers on backed up file's icons.
  By selecting/un-selecting Show backup markers on icons.

- Show/hide hidden files and folders from the My Computer tab in Modify data selections.
  By selecting/un-selecting Show hidden files in the My Computer tab during data selection.
The System Tray Agent

The System Tray Agent, located next to the clock on your computer, enables quick access to the Dashboard. The agent's icon gives a quick display of the backup status. Mouse over it for the actual status.

System Tray Agent's states

- Genie Timeline is monitoring changes.
- The backup is paused.
- Genie Timeline requires attention.
- Error in backup.
- The blue circle fading-in and out means the backup is running.
Running backups

Running Backups

There is no need to schedule backups using Genie Timeline as the backup process runs automatically in the background. Although it is not recommended, users can stop backups by pausing the backup process, pausing will cause the protection level to drop. In addition, pausing a backup will not enhance your computer performance, because the backup is light-weighted, so it will not use many resources.

Pause/Resume Backup

Although Genie Timeline runs automatically in the background, users can control the backup process by pausing and resuming backup. If a user pauses a backup while Genie Timeline is currently backing up a file, Genie Timeline will continue backing up where it left off.

To Pause the Backup

Method 1:

1. Right click the System Tray Agent located by your system clock.
2. Click Pause.

Method 2:

1. Open Dashboard.
2. Click Pause.

To Resume the Backup

Method 1:

1. Right click the System Tray Agent.
2. Click Resume.

Method 2:

1. Open the Dashboard.
2. Click Resume.

Notes

- Once the system reboots while the backup is paused, Genie Timeline will automatically resume backing up to ensure complete system protection.
- Pausing the backup is not recommended as it will reduce the protection level and will not enhance system performance. Genie Timeline backup runs on minimum requirements and automatically adjusts its resource use based on the usage of other programs.

Force a backup to run
Users can force a backup to run at anytime to ensure all changes since the last backup are included.

To force a backup to run

1. Open the Dashboard.
2. Click Run now located under status.

**Note**

Disaster Recovery will run every 7 days regardless if Run now is enabled or not.

**Backup modes**

Genie Timeline has different modes to adapt with different computing environments, these modes are:

Smart Mode: Enable automatic adjustment of backup speed based on user activity to run seamless in the background; faster backup when computer is idle. This mode can be activated from the Dashboard.

Turbo Mode: Run backup at Turbo speed for a faster completion. In this mode, Genie Timeline will consume more resources, so it is recommended to enable this mode when the machine is idle. This mode can be activated from the Dashboard.

Game/Movie Mode: Use this mode to pause backups and suppress pop-ups while playing games, movies, or viewing presentations. This mode can be enabled from Advanced Settings.

Power Saving Mode: Use this mode to lower CPU usage while the PC is running on batteries. It will stop backup when the battery level becomes critical. This mode can be enabled from Advanced Settings.
Windows Enhancements

Genie Timeline's Windows Enhancements make accessing backed up data and managing backups easier. These enhancements are:

**Timeline Explorer**: A virtual drive in My Computer to view all backed up data in a 2-dimension Windows Explorer.

**Backup markers**: Colored dots on the backed up files to view which files are backed up, modified, or not added to the backup.

**Context menu options**: Right-click files and folders to add to backup, exclude from backup, and show backed up versions.

**Explore Timeline**: Open any folder location in **Timeline Explorer**.

**No-Backup Zone**: Drag-drop any file to this folder location on the Desktop to exclude from backup.

**Note**

To disable Windows Enhancement features, go to **Windows Explorer Enhancements** preferences.

Backup markers

The backup markers are dots on each file or folder icons protected by Genie Timeline.

Backup markers indicators

- The latest version of the file is included in backup.
- The file has been modified since the last backup.
- The file has not been backed up.
- The folder contents are partially or fully backed up.
Context menu options

When a user right clicks a file or folder, the following functions can be performed

Add to backup: Right click any file or folder to include in backup.

Exclude from backup: This will exclude this folder or file from backup but will not delete older backed up versions.

Show Versions: Right click a file to view previous backed up versions.

View all deleted files: On an empty location in a folder, or on a folder, right click and select this option to view deleted files that were deleted from the backed up location.

To access context menu options

1. In Windows> Right click a file or folder.
2. Point to Genie Timeline.

Note

Context menu options can be enabled/disabled from Windows Explorer Enhancements preferences.

Timeline Explorer

The Timeline Explorer is fully integrated with Windows Explorer. Users can drag the Timeline slider to a specified tick and the tick will show how the selected files were at that point of time.

With Timeline Explorer, users can:

1. View files stored in the backup at a specific time frame.
2. Drag-drop files to any location.
3. Copy files to any location.
4. Restore files to original or alternate location, with a right-click.
5. View file versions by right clicking the file > Show Versions.
6. Open Files with a double click.

To access Timeline Explorer

Method 1:

1. Open My Computer.
2. Open Timeline Explorer.

Method 2:

1. Go to the Dashboard.
2. Under Restore, select Restore from Timeline.

Method 3:
1. From the File menu in the Dashboard. 
2. Select Timeline Explorer.

**Method 4:**

1. From the Mini-Dashboard. 
2. Select Timeline Explorer.

**Notes**

- Timeline will only display files in the active backup, older backups can be viewed/restored via the Advanced Restore.
- You can disable/enable Timeline Explorer from Windows Explorer Enhancements.
- If the backup is encrypted the password must be entered to continue restoring or opening files.

**Explore in Timeline from any Window**

In any backed up location, users have the ability to view it via Timeline Explorer.

To use Explore Timeline

1. Open any backed up location in My Computer/Computer. 
2. Click **Explore Timeline** located next to the Windows standard buttons under the Menu bar.

**No-Backup Zone**

The No-Backup Zone is located on the Desktop. This zone is a place to save files and folders that users do not want to add in the backup. To remove this location, simply remove all contents from it and delete it off the desktop.
Restoring

View/Restore Files

Genie Timeline offers easy to use, easy to access methods to restore and view backed up data. Users can restore/view data in more than one way:

- **Timeline Explorer**: The Timeline enables you to view all files and folders backed up, it is fully integrated with Windows Explorer.
- **Deleted Files View**: Right click a location or folder to view and recover deleted files that were backed up.
- **Advanced Restore**: This wizard enables restoring files at a specific date and also set a different location to restore in case of multiple backup jobs stored in different locations.

**Note**

If the backup is encrypted the password must be entered to continue restoring or viewing files.

Timeline Explorer

**Timeline Explorer**

The Timeline Explorer is fully integrated with Windows Explorer. Users can drag the Timeline slider to a specified tick and the tick will show how the selected files were at that point of time.

With Timeline Explorer, users can:

1. View files stored in the backup at a specific time frame.
2. Drag-drop files to any location.
3. Copy files to any location.
4. Restore files to original or alternate location, with a right-click.
5. View file versions by right clicking the file > Show Versions.
6. Open Files with a double click.

To access Timeline Explorer

**Method 1:**

1. Open My Computer.
2. Open Timeline Explorer.

**Method 2:**

1. Go to the Dashboard.
2. Under Restore, select Restore from Timeline.

**Method 3:**

1. From the File menu in the Dashboard.
2. Select Timeline Explorer.

**Method 4:**
1. From the Mini-Dashboard.
2. Select Timeline Explorer.

**Notes**

- Timeline will only display files in the active backup, older backups can be viewed/restored via the Advanced Restore.
- You can disable/enable Timeline Explorer from Windows Explorer Enhancements.
- If the backup is encrypted the password must be entered to continue restoring or opening files.

**View files in Timeline Explorer**

Genie Timeline is fully integrated with Windows Explorer to browse backed up data in a user-acquainted environment.

To view backed up data:

1. Open My Computer/Computer.
2. Open Timeline Explorer.
3. Use the Timeline slider to go back to a specific time frame.
4. Explore the contents of the backup at that point of time.

**Notes**

- Users can:
  - Double click a file to open it.
  - View file versions by right clicking the file> Show versions.
  - View file details in Windows Explorer by going to the View menu> Details or right click a file> Properties.
- When encryption is enabled, users will be prompted to enter the encryption password when opening or restoring a file.
- Timeline will only display files for the current backup, backups that are located on different locations can be viewed/restored via Advanced restore.

**Restoring from Timeline Explorer**

After viewing the data you wish to restore, you have a variety of options to restore the data:

1. **Drag-drop** files/folders in any location.
   
   Hold the mouse down on the specified data, move it to the new location and release.

2. Use **copy** and **paste** function.

   This can be done by:
   
   - Right click an empty location> Paste
Restoring

- Press (ctrl+v) in the specified location

Select data you wish to restore (ctrl+mouse click/ shift+mouse click/Shift+ arrows) then either

- Right click the selected data> Copy
- Press (ctrl+C)

3. **Restore to Original or Alternate location**

   Right click the file> select Restore to alternate location

   Right click the file> Select Restore to original location

4. **Restore an older version**

   3.
   1. Right Click the file> Select Show versions
   2. Select the version and click restore

**Notes**

- It is highly recommended to restore system and program files using Disaster Recovery.
- When encryption is enabled, users are prompted to enter the encryption password prior to restoring.
- Timeline will only display files in the active backup, backups that are located on different locations can be viewed/restored via the Advanced Restore, for more information go to Restore from a different backup.
- Restore can only restore one file at a time, users can drag-drop or copy paste multiple files/folders if needed.

**Advanced Restore**

**Title**

**Advanced Restore**

This Wizard enables you to restore all data at a specific time period with more enhanced options like restore to a different location, restore all profile settings, and restore from an older backup.

To access the Advanced Restore:

1. Open the Dashboard.
2. Under the Restore section, click Advanced Restore.

**Notes**
• When encryption is enabled, users will be prompted to enter their encryption password before proceeding to the Restore Options.
• You can search for a specific file in the search text box and Search the Timeline will open in your default web browser with the results.
• Restoring single files without folder structure can be done via View Timeline.

Title

Select data to restore

Genie Timeline Advanced Restore, gives the user the ability to restore all or selected files. Therefore, in this page, the user will select the data to restore.

To select data to restore

1. Move the Timeline slider to select the time frame to restore data from.
2. Expand the folder structure to browse for the files and folders needed to be restored.
3. Select the files, blue check marks indicate that all files and folders are selected, grey indicates partial selection.
4. Click next to proceed to restore options.

Notes

• Restoring system and program files (disaster recovery data) is not recommended in the advanced restore. Use the Disaster Recovery option.
• To restore from a different backup, click on Restore from an older backup to browse and locate the backup you wish to restore from.

Restoring from an older backup

Every time a user chooses a new destination to backup to, the old backup database is closed and the active one is the default view in Advanced Restore and Timeline Explorer. Restoring from an older backup can be done from the Advanced Restore.

To restore from an older backup

1. Open Advanced Restore from the Dashboard.
2. Browse for the drive/destination that has the older backup, or browse for the "_Genie Timeline" folder.
3. If there is more than one backup on the drive/destination, Genie Timeline will load the backups that are on the location to select from the list.
4. Move the Timeline slider to select the time frame to restore data from.
5. Expand the folder structure to browse for the files and folders needed to be restored.
6. Select the files, blue check marks indicate that all files and folders are selected, grey indicates partial selection.
7. Select the data you wish to restore.
8. Click next to proceed to restore options.
Notes

- When encryption is enabled, you will be prompted to enter the encryption password before proceeding to the Restore Options.

Title

Set Restore Options

With these options, users can specify where to restore the items and solve restore conflicts with files that have the same name.

To change Restore location

1. Under Restore location select Restore to an alternate location.
2. Click the Browse button to browse and select for the location attended to restore to.

Replace existing file options

If one or more backed up files are selected for restoring, and they already exist in the restore location, the following options can be used to resolve conflict:

- Replace the file only if the backed up file is newer: If the file being restored is newer than the one already existing on the restore destination, Genie Timeline will replace it with the one in the backup.
- Do not replace any files: If the file already exists on the restore destination, do not restore the backed up file.
- Always replace files: Replace all files from the backup, regardless if newer.

Title

Restore Progress

In this section, the progress of the restore is divided into:

Restore Status

The status gives an overview of the restore progress showing the following:

Restoring: Displays the path of the file currently being restored.

Restored: The number of items restored.
Size: The size of data restored.
Failed: Number of items failed to restore.

Restore Progress bar
An overall percentage of how many files are restored.

Notes
- To cancel restoration, click abort during the process.
- After restore completes, click on View log for detailed log of all items restored.

Disaster Recovery

In order to restore your system files and settings to a previous state, you will need to:

1. Make sure Disaster Recovery is selected on the Smart Selections page.
2. Create or prepare your Disaster Recovery startup disk.
3. Restart your computer and boot from the Disaster Recovery startup disk to enter the Disaster Recovery wizard.

The Disaster Recovery selection will backup your entire System Drive which includes the following folders every 7 days:

- Windows Folder
- Program Files
- User Folders
- System State

To Provide up to date complete system protection in case of failure.

Note
Disaster Recovery is not supported for standard or limited users. Please login to an administrator account to create a Disaster Recovery backup.
Disaster Recovery wizard

Disaster Recovery Restore

Once you boot up your PC with the Disaster Recovery startup disk, the Disaster Recovery restore wizard will pop-up.

The Wizard consists of:

Disaster Recovery welcome page

Step 1: Select the Backup

Step 2: Select a Restore Point

Step 3: Set Restore Options

Once the Disaster Recovery completes, it will reboot your computer back in Windows.

Disaster Recovery welcome

This page directly appears right after the computer boots with the Disaster Recovery startup disk.

To start Disaster Recovery, click on the Start Disaster Recovery button.

Additional Tools

The following tools are useful to prepare for the disaster recovery process:

Map Network drive: Map network locations.

View Network Status: View the status of the network connections.

Command Prompt: Open Windows Command Prompt.

Title
Step 1: Select the Backup

In this page, you will need to select what backup to restore from or browse for the backup manually. Only Backups with Disaster Recovery data can be restored.

To select a backup

1. From the auto-generated list, select the backup you wish to restore from, if the backup is not listed, click on Select a different location and locate your backup.
2. Click next to proceed.

Note

If you have just connected an external drive, click refresh to re-scan drives.

Step 2: Select a Restore Point

In this step you can select any time frame to restore from. Even if the snapshot did not have disaster recovery backup, it will restore the latest data right before that snapshot.

To select a restore point

1. From the Restore Points list, select a restore point.
2. Click next to proceed.

Step 3: Set Restore Options

In this step, users have the ability to restore Windows Master Boot Record (MBR) and how to replace files

Restore MBR

This will restore the Windows Boot Manager. The Master Boot Record (MBR) is a small program located in the very first sector of the Hard Drive that contains a list of partitions on the disk. It also determines what partition to boot from. To ensure that your system can boot correctly, it is important for the correct MBR to be installed. If your system does not load, be sure to select this option. Otherwise, you may choose to uncheck it.

To Restore MBR
Under System Data > Select Restore Master Boot Record.

**Restore Type**

This option is used to specify how to restore files, either by only restoring missing files using **instant restore**, or **full restore** where it will replace all system and program files.

If the user selects full restore, they have these options for restoring user data:

- **Keep the latest copy of all user files**: This will only restore user data files if what is backed up is newer.
- **Replace everything**: Overwrite all user data with what is in the backup.

**Searching the Backup**

Users have the option to search files in the backup using the entire file name or part of it:

To Search the Backup

**Method 1:**

1. Open the [Dashboard](#).
2. Type in the search term in the search backup text-box located at the right corner of the Dashboard.
3. Press Enter or click the search icon.

**Method 2:**

1. Open [Advanced Restore](#).
2. Type in the search term in the search backup text-box located in the bottom-left side of the page.
3. Press Enter or click the search icon.

**Method 3:**

1. Right-click the system tray agent.
2. Click Search.
3. Type in the search term and press enter or click on the search icon.

**Notes**

- When encryption is enabled, users will be prompted to enter their encryption password when opening a file.
- The search will only display files in the active backup, backups that are located on different locations can be viewed/restored via [Advanced Restore](#).
**Retrieve deleted files that have been backed up**

Genie Timeline enables users to display a list of deleted files that are backed up with a simple click.

To Retrieve deleted files

1. Open the location of the deleted file.
2. Right click in an empty location.
3. Select View all Deleted Files.
4. A list of deleted items will appear, point to the deleted file, and select the version you wish to restore.
5. Click Restore this version and the file will restore to the location it was deleted from.

**Notes**

- You can restore deleted items from the [Timeline Explorer](#) and [Advanced Restore](#).
- When encryption is enabled, you will be prompted to enter the encryption password when restoring.
Logging and Reports

Restore log

The restore log gives a detailed list of files that restored successfully and failed to restore.

To open the restore log

1. Restore files from Advanced Restore.
2. Once the Restore Progress completes, click View log.

Advanced logging

Advanced logging is accessed from the Preferences under Advanced Settings in the Tools menu. Enabling these logs gives a trace of the software’s activity used for troubleshooting purposes by the Genie9 technical support team.

To Enable Advanced logging:

1. Open the Dashboard.
2. Go to Tools, select Advanced Settings, and click on Preferences.
3. Under General, select Enable advanced logging for debugging.
4. Click Open advanced logs folder.
5. Click ok to save changes.
6. Replicate the scenario and send the logs from the advanced logs folder.
Index

A
Add ......................................................... 31
Advanced ...................................... 26, 46, 55
Advanced Encryption Standard .............. 13
Advanced Restore .......................... 29, 47, 48
Advanced Settings ................... 25, 26, 27, 55
AES ................................................... 13, 22
Auto Exclude ...................................... 36, 37
Auto Exclude Specific Files .................. 36
B
Backup changed ....................................... 12
Backup controls ..................................... 35
Backup Destinations ....................... 14, 16
Backup drives ..................................... 14
Backup markers ................................. 42
Backup modes ..................................... 41
Backup Schedule .................................. 25
Backup Status ................................. 27, 34
Blackberry Desktop ......................... 20
Bookmarks ......................................... 17, 18
C
CDP ................................................. 25
Change Backup Destination ............... 16, 25
Change backup drive .......................... 25
Compression ...................................... 14, 16, 22

Computer .............................................. 44
Configure email notifications .................. 27
Context menu ..................................... 31
Context menu options ......................... 43
Continuous Data Protection .................. 10, 25
CPU ................................................... 41
Creating
File Filters ........................................ 22
Customize Backup ......................... 26
D
Dashboard ............................................... 34
Data .................................................. 17, 46
Data Selections ................................... 21
Database ............................................ 18
Deduplication .................................... 13
Delete ........................................... 11, 30, 32, 44, 54
Deleted Files View ............................... 45
Deleting files .................................. 11
Desktop .............................................. 17
Disaster Recovery ......................... 30, 50, 51
Disaster Recovery Files ..................... 17
Disaster Recovery Restore ................... 51
Documents ........................................ 17
Drive becomes full ............................ 14
<table>
<thead>
<tr>
<th>E</th>
<th>Genie Timeline User Manual</th>
</tr>
</thead>
<tbody>
<tr>
<td>EBooks</td>
<td>EBooks .............................................................. 17</td>
</tr>
<tr>
<td>Email</td>
<td>Email ......................................................................... 26, 34, 35</td>
</tr>
<tr>
<td>Email Notification</td>
<td>Email Notification .................................................. 27</td>
</tr>
<tr>
<td>Emails</td>
<td>Emails ......................................................................... 17</td>
</tr>
<tr>
<td>Enable File Retention</td>
<td>Enable File Retention ............................................. 26</td>
</tr>
<tr>
<td>Enable Filters</td>
<td>Enable Filters ................................................................ 22</td>
</tr>
<tr>
<td>Enable Power Saving</td>
<td>Enable Power Saving .................................................. 26</td>
</tr>
<tr>
<td>Encryption</td>
<td>Encryption ..................................................................... 13, 16, 22</td>
</tr>
<tr>
<td>Enter Serial Number</td>
<td>Enter Serial Number .................................................... 7</td>
</tr>
<tr>
<td>Exclude</td>
<td>Exclude .......................................................................... 21, 32, 44</td>
</tr>
<tr>
<td>Exclude files</td>
<td>Exclude files .................................................................. 32</td>
</tr>
<tr>
<td>Explore Timeline</td>
<td>Explore Timeline .......................................................... 31, 44</td>
</tr>
<tr>
<td>External Hard Drive</td>
<td>External Hard Drive ................................................... 15</td>
</tr>
<tr>
<td>F</td>
<td>F ..................................................................................</td>
</tr>
<tr>
<td>Favorites</td>
<td>Favorites ........................................................................ 17</td>
</tr>
<tr>
<td>File</td>
<td>File ................................................................................</td>
</tr>
<tr>
<td>Right Click</td>
<td>Right Click ..................................................................... 46</td>
</tr>
<tr>
<td>Financial Files</td>
<td>Financial Files ............................................................ 17</td>
</tr>
<tr>
<td>Folder</td>
<td>Folder ........................................................................... 24</td>
</tr>
<tr>
<td>Force</td>
<td>Force ............................................................................... 40</td>
</tr>
<tr>
<td>Free iPhone App</td>
<td>Free iPhone App ................................................................ 27</td>
</tr>
<tr>
<td>G</td>
<td>G ..................................................................................</td>
</tr>
<tr>
<td>Game/Movie Mode</td>
<td>Game/Movie Mode ................................................................ 41</td>
</tr>
<tr>
<td>General</td>
<td>General .......................................................................... 36</td>
</tr>
<tr>
<td>Genie Block Level Incremental</td>
<td>Genie Block Level Incremental ....................................... 12</td>
</tr>
<tr>
<td>Installing</td>
<td>Installing ....................................................................... 7</td>
</tr>
<tr>
<td>Genie Timeline App</td>
<td>Genie Timeline App .................................................... 27</td>
</tr>
<tr>
<td>Genie Timeline license</td>
<td>Genie Timeline license ................................................ 7</td>
</tr>
<tr>
<td>Genie Timeline Monitor</td>
<td>Genie Timeline Monitor ............................................... 27</td>
</tr>
<tr>
<td>Google Chrome</td>
<td>Google Chrome ................................................................ 17, 18</td>
</tr>
<tr>
<td>I</td>
<td>I ..................................................................................</td>
</tr>
<tr>
<td>Inaccessible</td>
<td>Inaccessible ................................................................... 14</td>
</tr>
<tr>
<td>IntelliCDP</td>
<td>IntelliCDP ....................................................................... 10</td>
</tr>
<tr>
<td>Internet Explorer</td>
<td>Internet Explorer .......................................................... 17, 18</td>
</tr>
<tr>
<td>Interrupted</td>
<td>Interrupted ...................................................................... 12</td>
</tr>
<tr>
<td>IPhone</td>
<td>IPhone ........................................................................... 20, 26, 27</td>
</tr>
<tr>
<td>IPhone/iPad/iPod</td>
<td>IPhone/iPad/iPod ............................................................ 17, 20</td>
</tr>
<tr>
<td>IPod</td>
<td>IPod ............................................................................... 20, 26</td>
</tr>
<tr>
<td>ISO Image</td>
<td>ISO Image ......................................................................... 28</td>
</tr>
<tr>
<td>ITunes</td>
<td>ITunes ............................................................................ 20</td>
</tr>
<tr>
<td>L</td>
<td>L ..................................................................................</td>
</tr>
<tr>
<td>Location</td>
<td>Location ......................................................................... 25</td>
</tr>
<tr>
<td>M</td>
<td>M ..................................................................................</td>
</tr>
<tr>
<td>Machine Level deduplication</td>
<td>Machine Level deduplication .......................................... 13</td>
</tr>
<tr>
<td>Manage Backup</td>
<td>Manage Backup ................................................................ 24</td>
</tr>
<tr>
<td>Manage Backups</td>
<td>Manage Backups ................................................................ 35</td>
</tr>
<tr>
<td>MBR</td>
<td>MBR ................................................................................ 52</td>
</tr>
<tr>
<td>Microsoft Money</td>
<td>Microsoft Money ................................................................ 18</td>
</tr>
<tr>
<td>Microsoft Office</td>
<td>Microsoft Office ................................................................ 18</td>
</tr>
<tr>
<td>Mobile Device Backup</td>
<td>Mobile Device Backup ................................................... 20</td>
</tr>
</tbody>
</table>
Index

Modify Data Selections .................20, 21, 24
Modify Windows Explorer Enhancements.....36
Movie ......................................................26
Mozilla Firefox .....................................17, 18
Multiple ...................................................13
Music.......................................................17
Music Files .............................................17
My Computer............... 13, 17, 21, 24, 31, 44
My Computer tab ...........................24
My Documents.......................... 17, 18
My Music........................................................17, 18
My Photos.....................................................17, 18
My Videos....................................................17, 18
N
New backup ......................16, 29, 35
New Backup Job....................29
O
Office Files .............................................17
Older backup ................................. 29, 48
Open current location .................31
Open Files ..........................................11, 43, 45
Opera ..................................................... 17, 18
Outlook Express..............................17
Outlook Profiles .....................................17
Outlook PST file ......................................12
P
Paste ..................................................................46
Pause .........................................................12, 35, 39, 40, 41
Pdf ..........................................................18
PDFs......................................................17, 18
PeachTree ................................................18
Photos ......................................................17
Power Saving Mode .........................41
Preferences ............................................. 36, 37, 55
Preferences window..........................38
Preselected Data ..............................13, 17
Presentations.................................. 18, 26, 41
Product Info .............................................. 7
Project Files........................................18
Protection Level ........................................34
PST .........................................................12
Publisher ..................................................18
Q
Quickbooks...............................................18
Quicken ...................................................18
R
Remove ...................................................37
Repair....................................................... 8
Restore . 11, 29, 30, 43, 45, 46, 47, 48, 49, 50, 51
Restore deleted files ......................43
Restore log..............................................55
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore my data</td>
<td>47</td>
</tr>
<tr>
<td>Restore Options</td>
<td>49</td>
</tr>
<tr>
<td>Restore Settings</td>
<td>49</td>
</tr>
<tr>
<td>Resume</td>
<td>12, 35, 40</td>
</tr>
<tr>
<td>Retrieve Deleted Files</td>
<td>30, 54</td>
</tr>
<tr>
<td>right click</td>
<td>31, 46</td>
</tr>
<tr>
<td>Right-click</td>
<td>42, 43</td>
</tr>
<tr>
<td>Run Backup</td>
<td>40</td>
</tr>
<tr>
<td>Running</td>
<td>40</td>
</tr>
<tr>
<td>Same file</td>
<td>13</td>
</tr>
<tr>
<td>Schedule</td>
<td>10, 25, 35</td>
</tr>
<tr>
<td>Search</td>
<td>29, 53</td>
</tr>
<tr>
<td>Search Backup</td>
<td>35</td>
</tr>
<tr>
<td>Security</td>
<td>13, 22</td>
</tr>
<tr>
<td>Select Backup Destination</td>
<td>16</td>
</tr>
<tr>
<td>Select Backup Drive</td>
<td>16</td>
</tr>
<tr>
<td>Select Data</td>
<td>17, 21, 24, 35</td>
</tr>
<tr>
<td>Select files</td>
<td>21, 24, 43, 45, 48</td>
</tr>
<tr>
<td>Set Security</td>
<td>21, 43, 45, 48</td>
</tr>
<tr>
<td>Setup Wizard</td>
<td>16, 29</td>
</tr>
<tr>
<td>Show Versions</td>
<td>32, 43, 45</td>
</tr>
<tr>
<td>Smart Mode</td>
<td>35, 41</td>
</tr>
<tr>
<td>Smart Selection</td>
<td>13, 16, 17, 24</td>
</tr>
<tr>
<td>Spreadsheets</td>
<td>18</td>
</tr>
<tr>
<td>Start</td>
<td>29</td>
</tr>
<tr>
<td>Start Disaster Recovery</td>
<td>51</td>
</tr>
<tr>
<td>Status</td>
<td>26, 34, 40</td>
</tr>
<tr>
<td>System Requirements</td>
<td>7</td>
</tr>
<tr>
<td>System Tray Icon</td>
<td>40</td>
</tr>
<tr>
<td>Timeline</td>
<td>43, 45, 46</td>
</tr>
<tr>
<td>Timeline Explorer</td>
<td>38, 42, 43, 44, 45, 46</td>
</tr>
<tr>
<td>Tools</td>
<td>26</td>
</tr>
<tr>
<td>Trail Period</td>
<td>7</td>
</tr>
<tr>
<td>TrueCrypt</td>
<td>13</td>
</tr>
<tr>
<td>Turbo</td>
<td>41</td>
</tr>
<tr>
<td>Turbo Mode</td>
<td>35, 41</td>
</tr>
<tr>
<td>Turbo Tax</td>
<td>18</td>
</tr>
<tr>
<td>Uninstall</td>
<td>8</td>
</tr>
<tr>
<td>Update</td>
<td>8, 36</td>
</tr>
<tr>
<td>Upgrade</td>
<td>8</td>
</tr>
<tr>
<td>USB Disk</td>
<td>28</td>
</tr>
<tr>
<td>USB Drive</td>
<td>28</td>
</tr>
<tr>
<td>User Data</td>
<td>52</td>
</tr>
<tr>
<td>Versions</td>
<td>11, 12, 30, 43, 46, 46</td>
</tr>
<tr>
<td>Videos</td>
<td>17</td>
</tr>
<tr>
<td>View files</td>
<td>46</td>
</tr>
<tr>
<td>View/Restore Files</td>
<td>45</td>
</tr>
<tr>
<td>Virtual Partition</td>
<td>28</td>
</tr>
</tbody>
</table>

60
Index

Visio.......................................................... 18
Volume Shadow Copy ................................. 11
W
WARRANTY DISCLAIMER ............................. 1
Windows .................................................... 28, 31, 46
Windows Address ........................................... 18
Windows Boot Manager ............................... 52
Windows Contacts ........................................ 18
Windows Enhancements ............................... 42
Windows Explorer ............................... 42, 43, 45, 46

Windows Explorer Enhancements .......... 43, 45
Windows Live Mail ................................. 17
Windows Mail ............................................. 17, 18
Windows Master Boot Record ................. 52
Wizard ........................................................ 45
Word .......................................................... 18
Z
ZIP ............................................................ 14
Zip compression ....................................... 22